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This document describes the new features, product enhancements, and other

improvements implemented in the Dragonfly and Dragonfly Pro 2021.3 software
release. You should read these release notes before you install this new version.
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New Features and Product Enhancements
Organizer

New Features and Product Enhancements

The 2021.3 software release for Dragonfly and Dragonfly Pro provides significant
enhancements for the Organizer, Window Leveling, and Segmentation Wizard, as well
as new surface inspection tools, calibration workflows, and measurement options.

Organizer

Dragonfly’s Organizer, which is entemprise ready for centralizing data within an inditute,
now features a new look and new options for organizing data-intensive projects.
Organizer, which is equipped with drag-and-drop functionality for adding objects from a
project to the current session and vice-versa, now includes the options to ‘Star’ and
‘Pin’ frequently referenced projects. Recently accessed projects also appear on the
newly implemented left sidebar.

Choose File > Open the Organizer on the menu bar to open the Organizer dialog, shown
below.

Organizer dialog

W Organizer - O X

Mai

Find: 'bone Q ®.
P EESFETRT

ysis - Femoral Head [1:

| Femur

* Sone £ istal Femur [10] (R ! e £ ied: 2021-05-03 17:51:06
Y Bone Analysis - Knee [11] e ! e [Projects/ Analysis) Last Modifie )7-13 14:37:04

2021-05-21

Organizer’s new interface includes a large search results panel that incorporates a
number of new options for viewing and organizing projects, as well as a left sidebar that
lists Starred and Recent projects, project tags, and lets you access the Settings dialog.

Starred... Quickly access frequently referenced data by ‘starring’ projects. Starred
projects appear in an easy-to-access list on the left sidebar.

Recent... Recently accessed projects are listed here. If required, you clear the Recent
list by right-clicking and then choosing Clear Recent List.

Dragonfly Release Notes Version 2021.3
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New Features and Product Enhancements
Organizer

Settings... New options in the Organizer Settings dialog, shown below, let you set the
size of icons and text.

B Organizer Settings X

Interface Ther th:
Network

Item height:

ng
Maintenance

Item font size:

A number of new options are available for each project listed in the search results
panel. You should note that each project can be expanded to view the available data or
collapsed to maximize space, as shown below.

Expanded and collapsed project listings

Bone Analysis - Femoral Head [12] Bone Analysis, Fo ] / i st Modified: 2021-07-12 14:2¢

i e . :
lume fraction (surface normals; proj

field (surface normals)

emoral-head
B

on to pr

Starred... Click the Star icon to add a prgect the easy-to-access ‘Starred’ list on the left
sidebar.

Pinned... Click the Pin icon to pin a project. Pinned projects will appear at the top of the
project list at all times.

Title... Includes the project name and additional information, if Show project details is
checked.

A number of additional items are available on hover for renaming projects, updating
objects that are open in the current scene, moving projects, and deleting projects.

You should also note that you can now drag-and-drop trained models between the
Organizer and the Deep Learning Tool and Machine Learning Segmentation dialogs and
vice versa. This lets you easily share models with other users on your network, as well
as provides the option to archive models with their training sets.

Object Research Systems (ORS) Inc.
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New Features and Product Enhancements
Window Leveling Panel with LUT Editor

Window Leveling Panel with LUT Editor

This Dragonfly release consolidates window leveling functions with LUT editing
capabilities, along with a number of 2D/3D settings previously available on the Data
Properties and Settings panel, within a reformatted Window Leveling panel.

The refactored Window Leveling panel, shown in the following screen capture, features:

e Selection of LUTs and tools for LUT editing, as well as color mapping and opacity
mapping modes.

¢ Piecewise opacity mode, as shown on the histogram below, with selectable color and
alpha control points and a color control point editor.

* New options for creating duplicate panels and pinning a panel to a selected dataset
and scene view.

Window Leveling panel

Window Leveling

¥ rawdata
Log ¥

r

¥ Selected control point

olor Alpha

Position {(normalized): 0.50 0.35
Position (physical): 12310.74 9184.51
Value: 0.87

¥ Lookup table (LUT)

I linear

ted range
1700.05

¥ Flotted ran

¥ Color mapping

T [k

¥ Opadity mapping

LT LT

Gamma:
mmS

Pin... In cases in which you are working with multiple datasets, you can *pin’ the
Window Leveling panel controls for LUT editing, color mapping, and opacity mapping to
a selected dataset.

Open... Click the “+" icon to create an additional instance of the Window Leweling panel,
which can be ‘pinned’ to another dataset.

Dragonfly Release Notes Version 2021.3
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New Features and Product Enhancements
Window Leveling Panel with LUT Editor

LUT Editor (Histogram and Control Points)

Dragonfly's look-up table (LUT) functions, which determine how regions within specific
arrays of intensity are displayed and colored, can now be applied and edited directly in
the Window Leveling panel to optimize the 2D and 3D views of datasets. Depending on
which LUT you choose, the difference between the original and remapped version can
be subtle or very dramatic.

The integrated LUT Editor, shown below, displays a plot of the current image’s look-up
table (LUT) that describes the shade or color that is displayed for each of the possible
pixel values, as well as its opacity. When set to “Piecewise”, control points are inserted
into the histogram that highlight regions within specific arrays of intensity. By
manipulating the color and alpha control points, the best overall contrast between
various features can be achieved. You can edit any of the available LUTs, as well as
create your own.

Histogram and control points

Log ¥

Alpha control points

Legend
Color control points

Alpha
0.6958

0995

¥ Lookup table (|
LUT selector and options

NoTE The LUT Editor that was available in previous Dragonfly versions was deprecated for
this software release. You can now edit a LUT directly in the Window Leveling panel, as
described below.

Alpha control points... Determines the opacity — from transparent to fully opaque — of
a region. The normalized position of the control point within the selected window, its
physical position (the value to which it corresponds), as well as the control point’s alpha
value, are indicated in the Selected control point box.

Legend... Displays the shades or colors of the selected LUT.

Color control points... Determines the shade or color applied to a region. The
normalized position of the control point within the selected window, its physical position
(the value to which it corresponds), as well as the control point’s color or colors, are
indicated in the Selected control point box.

Click the color swatch to open the Color Control Point Editor dialog. You can choose a
color for a control point in the dialog, as well as choose to split a control point and then
pick colors for the lower and higher values.

Object Research Systems (ORS) Inc.
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Window Leveling Panel with LUT Editor

Color Control Point Editor

W Color Control Point Editor X

tom colors

Lookup table (LUT)... The controls in the Lookup table (LUT) box let you choose a LUT
to apply to the selected data, as well as access options for distributing color points,
flipping the position of the control points, converting the alpha values to piecewise,
importing LUT settings, as well as resetting and saving LUTs.

The More button provides access to the following options:

Description

Distribute Color Control
Points Equally

Automatically distributes the color control points equally — either between the data range, if ‘Map to full
range’ is selected as the LUT mapping mode, or within the window, if ‘Map to Window’ is selected as the
LUT mapping mode.

Flip Color Control Points
Position (Horizontal Flip)

Automatically flips the position of the color control points horizontally.

Edit Discrete LUT

Opens the Discrete LUT Editor dialog, in which you modify the colors of a discrete LUT.

Distribute Alpha Control
Points Equally

Automatically distributes the alpha control points equally — either between the data range, if ‘Map to full
range’ is selected as the LUT mapping mode, or within the window, if ‘Map to Window’ is selected as the
LUT mapping mode.

Flip Alpha Control Points
Position (Horizontal Flip)

Automatically flips the position of the alpha control points horizontally.

Flip Alpha Control Points
Value (Vertical Flip)

Automatically flips the value of the alpha control points. For example, an initial value of 0.70 will become
0.30 when it is flipped.

Sample Alpha as Piecewise

Automatically adds alpha control points to the current window leveling mode as per the current alpha
distribution.

NoTE Not available if the current window leveling mode is ‘Piecewise’.

Import LUT Settings

Lets you import and apply the settings of another LUT to the current LUT.

Revert to Saved LUT

Resets the LUT back to its last-saved settings.

Save LUT As

Lets you save a new version of the selected LUT.

Delete LUT

Lets you delete a custom LUT.

NOTE You cannot delete any of the default LUTs.

Dragonfly Release Notes Version 2021.3
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New Features and Product Enhancements
Window Leveling Panel with LUT Editor

Color Mapping

You can choose two options for mapping LUT colors and shades to intensity values —
Map to full data range or Map to selected window — in the Color mapping box.

Color mapping options

Description

Map to full data range

If selected, color mapping will be applied independently of window leveling. This means that
shades and colors mapped to specific values will be retained whenever leveling values are
changed.

Map to selected window

If selected, colors will be mapped to the range of values defined by the window width.

Opacity Mapping

Previously available in the 3D settings box on the Data Properties and Settings panel,
the Opacity slider lets you adjust the global opacity of a dataset, while you can choose
a mapping mode in the Opacity mapping box.

Opacity mapping box

Vame

Gamma: D — .45

NoTE The Opacity Console that was available in previous Dragonfly versions was deprecated
for this software release.

The following Opacity mapping modes are available for 3D views in this software
release.

Opacity mapping modes for 3D views

Mode Icon Description
Left-gated ramp In this mode, the opacity of the values to the left of the lower threshold will be set to 0, while the
ﬂ upper threshold is disabled. The opacity of the values within the window will be set within a

linear ramp, which can be modified by adjusting the gamma.

Bi-gated ramp

= In this mode, the opacity of the values to the left of the lower threshold will be set to 0, while the
w opacity of the values to the right of the upper threshold will be set as per the highest value
within the window. The opacity of the values within the window will be set within a linear ramp,
which can be modified by adjusting the gamma.

Bandpass ramp

In this mode, the opacity of the values to the left of the lower threshold and to the right of the
w upper threshold will be set to 0. The opacity of the values within the window will be set within a
linear ramp, which can be modified by adjusting the gamma.

Bandpass Gaussian

n In this mode, the opacity of the values to the left of the lower threshold and to the right of the
u upper threshold will be set to 0. The opacity of the values within the window will be set within a
Gaussian window.

NoTE Gamma cannot be adjusted in this mode.

Bandpass constant

In this mode, the opacity of the values to the left of the lower threshold and to the right of the
u upper threshold will be set to 0. The opacity of the values within the window will set to a
constant 50%.

NoTE Gamma cannot be adjusted in this mode.

Object Research Systems (ORS) Inc.
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Mode Icon Description
Piecewise In this mode, the opacity of the values within the window will be set to the value of the alpha
m control points, while the opacity of the values to the left of the lower threshold will be set as per
the leftmost control point and the opacity of the values to the right of the upper threshold will be
set as per the rightmost control point.
NOTE You can convert other modes, such as Bi-gated ramp or Bandpass Gaussian to
‘Piecewise’ by choosing More > Sampled Alpha as Piecewise.
NoTE Gamma cannot be adjusted in this mode.
The following Opacity Mapping modes are available for 2D views in this software
release.
Opacity mapping modes for 2D views
Mode Icon Description

Allpass constant

i

In this mode, the opacity of the values within the window will set to a constant 50%.
NoTeE Gamma cannot be adjusted in this mode.

Bi-gated ramp

4

In this mode, the opacity of the values to the left of the lower threshold will be set to 0, while the
opacity of the values to the right of the upper threshold will be set as per the highest value
within the window. The opacity of the values within the window will be set within a linear ramp,
which can be modified by adjusting gamma.

Piecewise

el

In this mode, the opacity of the values within the window will be set to the value of the alpha
control points, while the opacity of the values to the left of the lower threshold will be set as per
the leftmost control point and the opacity of the values to the right of the upper threshold will be
set as per the rightmost control point.

NOTE You can convert other modes, such as Bi-gated ramp or Bandpass Gaussian to
‘Piecewise’ by choosing More > Sampled Alpha as Piecewise.

NoTeE Gamma cannot be adjusted in this mode.

Dragonfly Release Notes Version 2021.3
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Measurement Inspector

Measurement Inspector

Changes related to LUT editing that were implemented for the Window Leveling panel
(see LUT Editor (Histogram and Control Points) on page 9) are also available for the
Measurement Inspector, as shown below. You can open the Measurement Inspector by
right-clicking a multi-ROI, scalar mesh, graph, or vector field and then choosing
Measurement Inspector in the pop-up menu.

Measurement Inspector

Thickness

ement range

0 mm Max: 120,00 mm

O Ik

of range measurement

ol point
Color
Position (normalized):
Position (phy

Value:

¥ Look

NoTE The Measurement Inspector lets you plot the scalar values of an object and then highlight
selected ranges in the available 2D and 3D scene views.

Object Research Systems (ORS) Inc.
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New Features and Product Enhancements
Segmentation Wizard

Segmentation Wizard

The following new features and updates are available for the Segmentation Wizard in
this software release.

Monitor Model Training

To help monitor and evaluate the progress of training deep models in the Segmentation
Wizard, you can designate a frame for visual feedback. With the Visual Feedback option
selected, the model’s inference will be displayed in the Model Training dialog in real time
as each epoch is completed, as shown on the right of the screen capture below. In
addition, you can create a checkpoint cache so that you can save a copy of the model at
a selected checkpoint (see Enabling Checkpoint Caches on page 23 and Loading and
Saving Model Checkpoints on page 23). Saved checkpoints are marked in bold on the
plotted graph, as shown below.

Training dialog

M Training model ‘Seq\iz_U-Net_di-5_ifc-64_slices-3' u]

Do the following to enable visual feedback during training:

e Add a frame to a representative slice that does not include labeled training data.

e Click He Enable Frame for Visual Feedback button in the Frames list, as shown.

Dragonfly Release Notes Version 2021.3
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New Features and Product Enhancements | 15
Segmentation Wizard

Image Modalities

When working with multi-modality models, you can now reorder and rename your
datasets in the Image modalities prior to training. To reorder an item, simply drag it up
or down in the list, as shown below.

Reordering of image modalities

Training Parameters for Deep Models

This software release features additional training parameters for deep models, which
are available in the reformatted Training Parameters dialog. Right-click a model and
then choose Update Training Parameters to open the dialog, shown in the following
screen capture. You should note that the Training Parameters dialog now includes three
tabs — Settings, Advanced Settings, and Data Augmentation.

Training Parameters dialog

B Training Parameters X

Patd

Stride ratio:

Epochs number:

Loss function:

Algorithm: Adadelta

¥ Parameters

current deey

Settings... The basic settings for training a deep model are available on the Settings
tab. These include patch size, stride ratio, and epochs number, as well as loss function
and optimization algorithm.

You should note that data is now split to sample proportionally from each class instead
of proportionally from all the data with a minimum of one patch per area. For example,
if you had 3 patches in 2021.1, they would have been sampled into training, test, and

Object Research Systems (ORS) Inc.
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New Features and Product Enhancements
Segmentation Wizard

validation all having a single patch, regardless of labeling. That split would not be
possible in 2021.3 if one of the patches does not contain all of the dasses, since at least
one area would be missing at least one class.

Advanced Settings... This new set of training parameters, which are available on the
Advanced Settings tab shown below, lets you set learning rate patience and cooldown
as a fraction of the available training data available, as well as early stopping patience.

Advanced Settings tab

4.50  million [ training

ing computation:

ninimum 15

0.0001

You should note the following whenever you edit the ‘Reduce learning rate on plateau’
and ‘Early stopping’ settings:

¢ Training voxels count will be shown as a tooltip whenever you hover over the training
voxel count text, as shown below.

1 computation:

unt, minimurn 5

| training count, minimum

val_loss

auto

e With He As'a fixed value’ option checked, the computation section will be disabled
and the behavior will be “normal”.

e With He ‘Using the following computation’ option checked, the value in table will not
be editable, but will be updated with the calculation result.
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Data Augmentation... The options on the Data Augmentation tab, shown below, let you
augment the amount of training data available and to select the different
transformations that will be applied to simulate more data than is actually available.

Data Augmentation tab

te additional training data by augmentation

¥ Data augmentation settings

Augment

imum |2

Changes for Working with Frames

A number of interface changes were implemented for the Input tab, mainly a switch
from textual buttons to icons, as well as the addition of the option to display frame
statistics. This includes the total humber of voxels and labeled voxels, as well as the
number of voxels labeled for each class.

Frames panel

K K K

O

Options for frames

Description

Add new frame

Adds a new frame to the current view.

Import frame(s) from a multi-
ROI

Lets you import the frames from a multi-ROI that was exported from the Segmentation Wizard.

Export all frames as a single
multi-ROI

ROI and will be exported in the same shaped as the loaded dataset(s).

Remove selected frame(s)

Exports all frames as a multi-ROI. Exported frames will appear in the main context as a multi-
H Removes the selected frame or frames.

NOTE This item was previously available only for a single frame.

Object Research Systems (ORS) Inc.
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Segmentation Wizard

Description

Show statistics for all training
frames

m Opens the Frame Statistics dialog, which is shown below.

. Frame Statistics X
Frame 1
1048576

1048575 (

774115 (

47550 (4.5347%)
221797 (21.152 (19.0311%) 39416 (13.7922 304278 (19.496

5114 (0.4877%) L0871%%) 3937 (1.377¢ 11511 (0. 737

s label within the training data.

For each frame, the total number of voxels and training (labeled) voxels, as well as the number
of voxels labeled for each class, is shown. In addition the percentage of voxels associated with
each class label within the training data is indicated.

NoTE The previously available Fill button was deprecated for this software release. The Fill
options are now available only in the contextual menu for a selected frame or frames.

In addition, a number of new options are available in the contextual menu whenever
multiple frames are selected, as shown below.

Contextual items for frames

Fill Selected Frames from Multi-ROI... Lets you fill the selected frames from a multi-
ROI. In this case, you can also choose to import the class names and colors.

Fill Selected Frames from Prediction... Lets you fill the selected frames from a
prediction.

Merge Selected Frames... Lets you merge the selected frames into a new one. You
should note that the frames must be on the same slice to enable this option.

Finally, a new option to create a copy of a frame is now available, as shown in the
following screen capture. For example, in cases in which you may want to “split” a
frame into two frames.
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Segmentation Wizard

Duplicate frame

1
Fit 'Frame 1'

Fill ‘Frame 1'

f

Frame 4

Models Tab

The Models tab now includes a Compute Score option, circled below, that lets you
update not available (NA) scores. For example, in cases in which training was stopped
manually and the model score was not computed.

Models tab

Name Score

Forest_A-M-2  NA

Publishing models... You should note that you need to ‘publish’ a model to make it
available to other features of Dragonfly, such as Segment with Al and the Deep
Learning Tool, for processing your data and other tasks. You can choose the models to
publish and edit the default publish name in the Publish Models dialog, shown below.

Publish Models dialog

M Publish Models X

Importing models... You should note that when a model trained in Dragonfly’s Deep
Learning Tool is now imported into the Segmentation Wizard, only patch stride, data
augmentation and callbacks will be updated. All other parameters will remain
unchanged.
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Segmentation Wizard

Model Generation Strategies

A number of new model generation strategies are now available in the Model Generation
Strategy dialog, shown below. The Model Generation Strategy dialog appears
automatically when you click Train for the first time. It can also be opened by clicking
the Model Generation Strategy button on the Models tab.

Model Generation Strategy dialog

. Muodel Generation Strategy X

.
Depth level: 4, Patch siz
count: 32

Use batch normalization: True

HEEEE

Single Model 1 (good and fast)... This new strategy includes U-Net with a 2D input
dimension, a depth level of 5, and an initial filter count of 64.

Single Model 2 (better and slower)... This new strategy includes U-Net 3D with an input
dimension of 3 slices, a depth level of 5, and an initial filter count of 64.

Single Model 3 (best and slow)... This new strategy includes U-Net with a 3D input
dimension of 3 slices, a depth level of 4, patch size of 32x32x32, an initial filter count of
32, and uses batch normalization.

Sparse Training Data... This new strategy, which can be used when only sparse labeling
is available, includes the two random forest models available in the Quick Start model
generation strategy.
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Deep Learning Tool

Updates for Dragonfly’s Deep Learning Tool include the option to visually monitor the
progress of training and to save a copy of a model at a selected checkpoint.

NoTE Support for Tensor Board, which provided the option to display various statistics in a
browser while training, is longer available as of version 2021.3. You should also note that
this callback was disabled by default in previous versions.

Monitoring Model Training

To help monitor and evaluate the progress of training deep models for semantic
segmentation and regression tasks, you can designate a 2D rectangular region for
visual feedback (see Setting Regions for Visual Feedback on page 22). With the Visual
feedback option selected, the model’s inference within the region will be displayed in
the Model Training dialog in real time as each epoch is completed, as shown below. In
addition, you can create a checkpoint cache so that you can save a copy of the model at
a selected checkpoint (see Enabling Checkpoint Caches on page 23 and Loading and
Saving Model Checkpoints on page 23). Saved checkpoints are marked in bold on the
plotted graph.

Training Model dialog

W Tisining model 'U-Net_dI-5 ifc-64'

Training Rest

Input

Inference

Time remaining:

Time remaining:
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Setting Regions for Visual Feedback

You can designate a 2D rectangular region for visual feedback to help monitor and
evaluate the progress of models for semantic segmentation and regression tasks. Do
the following to set a region for visual feedback:

1. Scroll to a representative slice within your input dataset.

2. With the Rectangle tool that is available on the Annotate panel, add a 2D
rectangular region that includes the area or features you want to monitor during
training.

NOTE Any region that you define for visual feedback should not overlap with your
training data.

3. Choose the required region in the Visual feedback drop-down menu on the Inputs
tab when you set the training inputs.

Visual feedback: | None
Mone

¥ Apply wisual-feedback-region

Input: Mone

NoOTE The visual feedback image for each epoch is saved when model training is
complete. You can review the result of each epoch by scrolling through the plotted
graph. If the checkpoint cache is enabled, you can also save the model at a selected
checkpoint when you review the training results (see Loading and Saving Model
Checkpoints on page 23).
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Enabling Checkpoint Caches

A new set of preferences are available in Dragonfly 2021.3 to enable the checkpoint
cache option and to set the size limits for the cache. Go to Preferences > Deep
Learning to open these new preferences, shown below.

Deep Learning preferences

B Preferences (C\Users\Windows T\AppData'Local\ORS\Dragonfly2021.3\preferencesml) O X

GPU card for Learning

GPL 0 - GeForce GTX 1070 Ti (6. 54GB available)

i 5
Annotations Enal kpoint cache
Configurable Actions -

Enable checkpoint cache... Check this item to enable the checkpoint cache.

Maximum cache disk space per model... Lets you set the per model limit for the cache
disk space. You should note that models will be saved at a checkpoint each time that it
has a better score until the cache limit is reached. Afterwards, the model with the
lowest score will be cleared so that the new checkpoint can be saved.

Total cache disk space usage... Indicates the total size of the checkpoint cache. If
required, you can clear the checkpoint cache by clicking Clear cache.

Loading and Saving Model Checkpoints

You can load and then save a model at a selected checkpoint by loading and displaying
the model’s training results. Right-click your trained model and then choose the
required training results in the Display Training History submenu to open the Training
dialog, shown in the following screen capture.
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Training dialog

W Taining m]

In the Training Results dialog you can:

e Scroll through the graph to visually evaluate the inference at different checkpoints.
e Select additional metrics to plot.

e Load a selected checkpoint by clicking Load Checkpoint. You can then save a copy of
the model at the loaded checkpoint.
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Filter with Al

The new Filter with Al feature lets you apply deep models trained for regression tasks,
such as denoising and super resolution, directly to your image data.

Choose Artificial Intelligence > Filter with Al on the menu bar or right-click the dataset
you want to process on the Data Properties and Settings panel and then choose Filter
with Al in the pop-up menu to open the panel to open the dialog shown below.

Filter with Al dialog

W Fitter with Al X

Deep Model:  U-Net_Denoise-High-Low

¥ Inputs

raw-data

Filter

NoTE By default, the Filter with Al panel is available on the Main tab and can be floated, if
required.

The following options are available on the Filter with Al panel.

Filter with Al options

Description
Deep Model Lets you choose a deep model trained for regression tasks. You should note that models are filtered
based on the current number of datasets selected.
Inputs Indicates the currently selected input(s).

« To change the selection, choose another item(s) in the Data Properties and Setting panel.

» For multi-input models, you change the order of the selected inputs by dragging an input, as shown
below.

Deep Model: U-Net_denai
¥ Inputs

NOTE Input order must be consistent with model training.
» For 3D models, you can modify the default Reference slice and Spacing setting, if required.
¥ Inputs

raw-data

1

Import Settings from Preview... Lets you import the settings from a selected 3D model preview.
Previews can be selected in the Chose a Preview to Import Settings dialog.
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Description
Preview Lets you generate previews using the currently selected regression model. You should note that previews
are limited to the visible voxels in the selected 2D view.
The following options are available for filter previews:
* You can choose different settings for the input(s). For example, input order for multi-modality models
and reference slice and spacing for 3D models.
» The opacity of the preview can be adjusted with the Preview opacity slider.
Filter Lets you choose how filtering will be applied, as shown below. The resulting filtered dataset will added to

the Data Properties and Settings panel when processing is complete.

With B

All slices... If selected, the full dataset will be processed.
Marked slices... If selected, only marked slices will be processed.
With mask... If selected, only data within the region of interest selected as the mask will be processed.

Machine Learning Segmentation

You should note that the option to preview results for Machine Learning (Classical)
models is now available at the bottom of the Machine Learning Segmentation dialog
from all tabs.

Preview options

Intensity:

O Leck Train
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Segment with Al

The following update is available of the Segment with AI feature, which lets you
automatically segment datasets with any of the deep learning or machine learning
models that you trained, imported, or downloaded.

In this software release, you can reorder your initial selection by dragging an input in
the Inputs box in the Segment with AI panel, as shown below.

Reordering of image modalities

. Segment with Al X

NoTE For multi-modality models, the order of the inputs for inference must be consistent with
the model training.
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Intensity Scale Calibrations

This software release provides the option to calibrate the intensity scale of multiple
images to a set of calibration standards. By setting-up a standard calibration, the
intensity values of different materials or tissue will be consistent, regardless of the
sample acquired.

The calibration procedure is done in three steps:

1. Create a set of calibration standards in the Dimension Unit Manager (see Creating
Calibration Standards on page 29).

2. Right-click the data you need to calibrate and then choose Calibrate Intensity Scale
in the pop-up menu. To calibrate an image, first select the appropriate calibration
standard in the Intensity Calibration dialog. You can then enter the raw intensity
values measured on the data you need to calibrate that correspond to the labels of
your standard.

B Intensity Calibration - O X

data-uncalibrated

Raw intensity (ps) Calibrated intensity (ps)

NOTE You can use the Probe tool to find the intensity values of different materials or
tissue in a dataset.

3. Choose the two selections that will provide the values for fitting. You can then click
the Calibrate button to calibrate the image.

W intensity Calibration - O X

data-uncalibrated
on unit: Phases
Calibrated intensity (ps)

15000

47250.00

NoTE If the calibration function is not satisfactory, you can change your selections
and then evaluate the re-calibrated intensity.
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Dimension Unit Manager

This new utility for Dragonfly 2021.3 lets you create new units, as well as calibration
standards for intensity scale calibrations. Choose Utilities > Dimension Unit Manager to
open the Dimension Unit Manager dialog, shown below.

Dimension Unit Manager dialog

. Dimension Unit Manager = O X

Available dim X
Unit name: |Ph

Calibrated-intensity

Phases Unit abbreviation: 'phs
— Calibration standards
Label Standard intensity
Phase 01 15000.0

Phase 02 26275.0

Phas 47250.0

Creating New Dimension Units

You can create new dimension units for either assigning to image data or for performing
intensity-scale calibrations.

Do the following to create a new dimension unit:

1. Choose Utilities > Dimension Unit Manager to open the Dimension Unit Manager
dialog.

2. Click the ‘+’ button on the bottom left to create a new unit.
3. Enter a name for the new unit and a unit abbreviation in the appropriate fields.

4. Click Save to save your new dimension unit.

Creating Calibration Standards

For intensity-scale calibrations, you will need to first create a dimension unit with
standard intensities for each phase or tissue type.

Do the following to create a calibration standard:

1. Create a new dimension unit in the Dimension Unit Manager dialog, if required (see
Creating New Dimension Units on page 29).

2. Add the required labels in the Calibration standards box and their associated
standard intensities.

NOTE You can use the Probe tool to find the intensity values of different materials or
tissue in a dataset.

3. Click Save.

NoTE Refer to the topic Intensity Scale Calibrations on page 28 for information about
calibrating your image data.
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Image Properties (Dimension Units)

The option to assign dimension (physical) units to a dataset is available in this software
release. For example, to images created from multi-ROIs with scalar values (see
Creating Images from Scalars on page 57).To assign a unit to your data, right-click the
required object in the Data Properties and Settings panel and then choose Image
Properties in the pop-up menu. Units are available in the drop-down menu on the
Image Properties panel, as shown below.

Image Properties panel

Pixels
1024
1024
512
|
Physical size

Type: UBYTE

cing (mm)
0.00095 Ofrset:

0.00085 Slope:

0.00095 Unit: | _.nastroms (A3)
Radian (%)

d Properties
Binary data (bd)

Generic discrete

This enhancement also includes better coherence when changing the units used in
scene views. For example, in cases in which the units of a distance map are converted
through the Change Unit options on the Scene’s Views Properties panel. You should also
note that for CSV exports, units will be converted to the selected scene view units.

NoTE Specifying a dimension unit is not a calibration, it is just an assignment. See Spatial
Scale Calibrations on page 31 for information about spatial scale calibrations.

NOTE You can create your own units in the Dimension Unit Manager. See Creating New
Dimension Units on page 29 for information about this new feature for Dragonfly.
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Spatial Scale Calibrations

You can now calibrate the spatial scale of images, regions of interest, and multi-ROIs so
that measurement results are presented with the correct values. To perform a spatial
scale calibration, you first need to use the Ruler tool to make a line selection that
corresponds to a known distance.

NoTE Calibrating an object will modify its current dimensions, making existing measurements
obsolete.

How to Perform a Spatial Scale Calibration
1. Open the image, region of interest, or multi-ROI that you need to calibrate.

2. Zoom-in on awe4 fiducial marker or object of known dimensions in a 2D or 3D view,
recommended.

NOTE You can remove image interpolation to better view the edges of the marker or
object in 2D views. To do so, choose Interpolation > Nearest in the 2D settings box
on the Data Properties and Settings panel.

3. Select the Ruler tool and then draw a line that is exactly the same length as the
marker or object.

4. Right-click the object you need to calibrate in the Data Properties and Settings panel
and then choose Calibrate Spatial Scale in the pop-up menu.

5. Choose the ruler you used to make the measurement in the Choose the Ruler to
Calibrate With dialog and then click OK.

. Choose the Ruler to Calibrate with.., X

Object: Ruler

\ Cancel

6. Enter the known length of the ruler in the Expected Length of Chosen Ruler dialog
and then click OK.

. Expected Length of Chosen Ruler X

Expected Length: 0.025 am

0K, Cancel

Spacing is updated automatically.
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Scalar Generator

With the new Scalar Generator for Dragonfly 2021.3, you can add measurements and
values to the classes within a multi-ROI, as well as to meshes, graphs, and vector
fields.

Right-click the object to which you want add scalar values and then choose Scalar
Generator in the pop-up menu to open the Scalar Generator dialog, shown below.

Scalar Generator dialog

. Scalar Generator = O X

Multi-ROI from ROI

p
th ROI or Shape

L
L
L
L
L
L
L
L
L
L
L
[ |

Measurement title: |Random

Number of

Scalar Values for Multi-ROls

The following measurements and values can be added to multi-ROIs in the Scalar
Generator dialog.

Measurements and scalar values for multi-ROls

Description

Basic Measurements

Lets you compute values, such as volumes, surface areas, Phi and Theta angles, aspect ratios, or the
centers of mass, corresponding to the classes within the selected multi-ROI.

NoTE Descriptions of these parameters are available in the Dragonfly Help system in the topic Statistical
Properties, which you can find in Specialized Workflows > Connected Components Analysis.

Basic Measurements with
Dataset

Lets you compute values, such as minimum, mean, maximum intensity values, weighted centers of
mass, and entropy, corresponding to image data and the classes within the selected multi-ROI.
NoTE Descriptions of these parameters are available in the Dragonfly Help system in the topic Statistical
Properties, which you can find in Specialized Workflows > Connected Components Analysis.

Constant

Lets you add a constant value to each class within the selected multi-ROI. You can choose a
measurement title and value for the constant, as shown below.

Measurement title:  my constant value

Constant value: [10.0
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Description

Intersection with ROI or
Shape

Lets you identify classes that intersect with a region of interest or a shape, such as a box, capsule,
cylinder, or sphere. You can enter a title for the measurement and choose the intersecting object.

Measurement title: Intersection with

Object: Sphere

Intersection (voxel count)
with ROI or Shape

Lets you find compute the number of voxels in classes that intersect with a region of interest or a shape,
such as a box, capsule, cylinder, or sphere. You can enter a title for the measurement and choose the
intersecting object.

Random Classes

Adds the specified number of classes to the selected multi-ROI. You can enter a title for the values and
choose the number of classes, as shown below.

Measurement title:  my constant value

Constant value: 10.0

NoTE The maximum number of random classes you can add is equal to the current number of classes.

Random Labels

Adds random labels to the selected multi-ROI.

Computed measurements and scalar values will be available in the Scalar information

box. The values for each dass can be viewed in the Classes and scalar information box,

as shown below.

Classes and scalar information box

nd scalar information

MName Count  Surface
phase 01 3

phase 02

phase 03

phase 04

phase 05

pha 5
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Measurements and Scalar Values for Meshes

The following measurements and scalar values can be added to or computed for meshes
in the Scalar Generator dialog.

Scalar Generator dialog

W 5calar Generator - O *

Thickness Mesh

Constant Vertex
Curvature

1 ROI or Shape
Mapping fr
Ray-Tradng Thickness

Measurement title: 'Mapping from

Multi-ROL

Measurements and scalar values for meshes

Description
Constant Vertex Adds a constant vertex value. You can enter a title for the measurement and choose the constant
value.
Curvature Adds curvature measurements computed with the Mean and/or Gaussian method.
Distance from Points Adds distance measurements computed from the mean position of a series of points.

NOTE You must first create a points set with the Points tool to enable this option.

Intersection with ROI or Lets you identify mesh edges that intersect with a region of interest or a shape, such as a box,

Shape capsule, cylinder, or sphere. You can enter a title for the measurement and choose the object to
intersect with.

Mapping From Lets you map the scalar values from another object, such as an image, multi-ROI, or scalar mesh.
You can enter a title for the measurement, as well as chose the object to map from and a default
scalar value.

NoTE Mapping from meshes is done with by closest face matching, while mapping from images and
multi-ROls is done through corresponding world coordinates. For best results, the number of distinct
objects in the selected mesh and multi-ROI should be equivalent.

Ray-Tracing Thickness Adds thickness values computed with the normal ray-tracing method (see Thickness Analyses on
page 59).

Dragonfly Release Notes Version 2021.3

TMO021-A-10



TMO021-A-10

New Features and Product Enhancements
Scalar Generator

Measurements and Scalar Values for Graphs

The following measurements and scalar values can be added to graphs in the Scalar
Generator dialog.

Scalar Generator dialog

W 5calar Generator - O x

Graph of Partides

Measurements

Constant E
Constan
Distance from Points
Connected Component
ath
Mapping from
W

on Component
Y

Measurement tite: 'Edge Length - Generated

Measurements and scalar values for graphs

Description

Constant Edge

Adds a constant edge measurement to the selected graph. You can enter a title for the measurement and
choose the constant value.

Constant Vertex

Adds a constant vertex measurement to the selected graph. You can enter a title for the measurement
and choose the constant value.

Distance from Points

Adds scalar values of measured distances from the mean position of a series of points. You can enter a
title for the measurement, as well as choose the required Points series.

NOTE You must first create a points set with the Points tool to enable this option

Edge Connected
Component

Adds edge connected components measurements, which is a representation of the labelization of the
graph. You can enter a title for the measurement.

Edge Length

Adds measurements equal to the length of the line connecting two branches or a brand and end node.
You can enter a title for the measurement.

Mapping From

Lets you map the scalar values from another object, such as an image, multi-ROI, or scalar mesh, to the
selected graph. You can enter a title for the measurement, as well as chose the object to map from and a
default scalar value.

Vertex Connected
Component

Adds vertex connected components measurements, which is a representation of the labelization of the
graph. You can enter a title for the measurement.

Vertex Connectivity

Adds measurements of connectivity, which is defined as the number of vertices (or edges) that are
connected to a vertex. You can enter a title for the measurement.
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Scalar Values for Vector Fields

The following scalar values can be added to graphs in the Scalar Generator dialog.

Scalar Generator dialog

W scalar Generator - O X

vector field

surements
tan
Mapping frc

ent title: Constant Vertex

tant value: |5

Scalar values for vector fields

Description

Constant Vertex

Adds a constant vertex measurement to the selected vector field. You can enter a title for the
measurement and choose the constant value.

Mapping From

selected vector field.

Lets you map the scalar values from another object, such as an image, multi-ROI, or scalar mesh, to the

Dragonfly Release Notes Version 2021.3

TMO021-A-10



TM021-A-10

PD

Range Min:

New Features and Product Enhancements
Annotations

Annotations

A number of new properties and settings are available for annotations, such as rulers,
arrows, points series, and scale bars, in this software release.

Ruler Properties

This software release introduces the concept of ‘projected rulers’ for 2D and 3D views.
As shown in the following screen capture, a projected ruler includes two lines that extend
from the start and end points of the annotation with an arrow that connects the two lines
and the measurement or custom caption.

Projected rulers in 3D view

A number of new settings are also available in the Properties box, as shown in the
following screen capture, for customizing the appearance of rulers in 2D and 3D views.
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Ruler properties
Bottom
Solid
Arrow head style: Barbed
[] Drop shadow
Background padding: Il
ptions Custom and Length
Caption: This is @ custom caption.
A &  AralBlack
Control point size:
Control point appearance:
Ruler (RulerZ) 255.66 mm
The following settings are available for rulers in Dragonfly 2021.3.
Ruler properties
Description
Thickness Indicates the thickness (in screen percentage) of the annotation.

« Enter a new number in the edit box to change the thickness of the selected ruler.

Align text horizontally

Lets you align text in 2D views horizontally — either at Start, Center, or at the End of the annotation.

Align text vertically

Lets you align text in 2D views vertically — either at the Top of Bottom of the annotation.

Line style

Lets you choose a line style — either Solid or Dashed — that will be applied to the annotation in 2D views.

Arrow head style

Lets you choose the style — None, Flat, or Barbed — of the arrow heads applied to the ruler.

Oriented caption

If selected, length captions will be aligned along the ruler in 2D views.

NOTE Not available for rulers shown in projected mode.

Show ticks

If selected, shows tick marks indicating the start and end points of the ruler in 2D views.

Drop shadow

If selected, adds a drop shadow to the annotation in 2D views.

Projected If selected, rulers will be shown in projected mode.
In this case, you can choose the orientation of the projection in the drop-down menu, as well as adjust the
distance from the ruler with the slider.

Background Lets you apply a stylized background to a ruler in 2D views as follows:

Show background... If checked, a solid background will appear in the 2D view of the annotation. You
can choose a color by clicking the color swatch.

Show border... If checked, a border will appear around the background in the 2D view of the annotation.
You can choose a color by clicking the color swatch.

Background opacity... This slider lets you adjust the opacity of the background, from 0% to 100%.
Background padding... This slider lets you adjust the size of the background.
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Description

Show captions

If selected, a caption will be shown with the annotation.
Length... When selected, the length of the ruler will be shown.
Custom... When selected, the text entered in the Caption edit box will be shown.

Show caption Custom and Length ~ ~

Caption: This i a custom caption.

Custom and Length... When selected, the length of the ruler, as well as the text entered in the Caption
edit box, will be shown.

NOTE You can choose a font for captions in the drop-down menu.

Control point size

Indicates the size (in screen percentage) of the annotation’s control points.
« Enter a new number in the edit box to change the size of the control points.

Control point appearance

Lets you choose a shape — Circle, Square, Triangle, Cross, or ‘X’ — for the annotation’s control points.
« Choose a shape in the drop-down menu to change th representation of the control points.

Ruler

Is the linear distance defined by the annotation on the image, in units according to the current

measurement scale.

« Enter a new value in the edit box to change the length of the annotation. You can also resize rulers by
dragging a control point.

Preferences for rulers... The new ruler properties can also be set as preferences.
Choose Preferences > Views > Annotations in the Preferences dialog to review and set
the ruler preferences.

Ruler preferences
Rulers
Show ticks [ show background [] Show border
Oriented caption [ Projected [ Drop shadow
Horizontal text alignment: Center

Vertical text alignment: Bottom

Line style: Solid

Arrow head: Barbed

Line thickness:
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Arrow Properties

In addition to being able to create and manipulate arrows in 3D views, a humber of
additional properties are also available for customizing the appearance of arrows and
arrow captions.

Arrows in 3D view

use
more cylinders in an engine yiekds two potential

benefits: first, the engine can have a larger
displacement with smaller individual reciprocating
masses

Intefral combUstion engines can contain any number of
Combustion charmbers (cylinders), with numbers
between ane and twelve being commen, though as

36 (Lycoming R-7755) have been used

re cylinders in an engine yields two potential
* benefils: first, the engine can have a larger
+ displacement with smaller individual reciprocating

masses

A number of new properties are available for selected arrows in the Data Properties and
Settings panel, as shown below.

Arrow properties

und padding:

ift + Enter.

Control pein

Control point appearance:
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NoTE Arrow 3D properties — Fixed size — was removed for this software release. It is now
possible, and more convenient, to adjust arrows directly in the 3D view.

Preferences for arrows... The new arrow properties can also be set as preferences.
Choose Preferences > Views > Annotations in the Preferences dialog to review and set
the arrow preferences.

Arrow preferences

Drop

Line style: Solid
head: Barbed

Line thickness:

Scale Bar Properties

The appearance and orientation of scale bars in 2D views and orthographic 3D views
can be customized through a contextual menu and set in preferences.

Customized scale bar in an orthographic 3D view

Right-click a scale bar to access the contextual menu, as shown below.

Pop-up menu for scale bars

Mo hash

Scale bar menu items

Description

Text Alignment

Lets you choose how text is aligned. Text can be aligned left, center, or right horizontally, as well as
vertically on the top or bottom of the scale bar.

Line Style

Lets you choose a line style that has no hash marks, end hash marks, or half hash marks.
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Histogram Analysis

Description

Set Specific Length

Lets you choose a specific length for the scale bar.

Set Automatic Length

Sets the length of the scale bar that automatically adjusts to the size of the view.

Show Numerical Text

If selected, shows the length of the scale bar.

Vertical

If selected, aligns the scale bar vertically.

Show Background

If selected, a semi-transparent background will be added to the scale bar.

Outline

If selected, an outline will be added to the scale bar.

Preferences for scale bars... The new options for scale bars can also be set as the
defaults. Choose Preferences > Views > Annotations in the Preferences dialog to review
and set the Scale bar preferences.

Scale bar preferences

Scale bar

Show scale bar Show background [ Vertical scale bar
[0 outlined Show numerical text

Horizontal text alignment: ' Left
Vertical text alignment: Bottom
Line style: Half hashes

Line thickness:

Histogram Analysis

Histogram Analysis now features more options for extracting scalar values and
measurements within regions of interest and shapes or along rulers, and also includes
selectable bin counts, which can be important in cases in which large or small bins can
lead to misleading results. As shown below, increasing the bin count when reviewing
data with a Gaussian distribution results in a smoother curve without the pronounced
spikes seen at smaller bins.

Limited bin count vs. more bins

Created Object Histogram

I Created Object Histogram

-

12

Frequency (%)

°

e

Freguency (%)

o
@

°
ke

s 100 125 150 175

e
o

Other updates include automatic refreshes in real-time as adjustments are made to
regions of interest, shapes, and rulers.
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MC X-Ray

A number of updates are available for Dragonfly’s MC X-Ray module, which can simulate
electron scattering in materials in order to correlate X-Ray emission to composition in
quantitative X-ray microanalysis. Choose Workflows > MC X-Ray Simulator to open the
MC X-Ray dialog.

Simulation Results

MC X-Ray’s simulation results were updated with plots for spectrum detected and
electrons detected as shown in the following screen captures. Additional updates
include an element line selector for computing X-ray intensities and an export to CSV
option.

Plots for electrons detected (bottom left) and spectrum detected (top right)

B MRAY Simulation Resutte

Spectrum detected

Photon count

I oA Simuttion: Resuts

Electrons detected

0 2500 5000 7500 10000 12500 15000 17500 20000
Energy (eV)

Spectrum Detected Bremsstrahlung Point 3
Spectrum Detected Characteristic Point 3

Spectrum Detected Total Poil

Electron count

2500 5000 7500 10000 12500 15000 17500
Energy (eV)
Energy Histogram Point 4

You can also choose to compute X-ray intensities for selected elements. Click the
Choose Presented X-ray Lines button in the X-ray intensities box to open the Element
Line Selector dialog, which is shown in the following screen capture.
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Element Line Selector dialog

W McxEAY Simulstion: Results .

Spectrum detected

W tiernent Line Selector ®

7500 10000 12500 15000 17500 20000
Energy (eV)

Spectrum Detected Bremsstrahlung Point 1 Spectrum Detected Total Point 1
Spectrum Detected Characteristic Point 1

Export results in CSV... For electron detector simulation results, you can export the X-Y-
Z coordinates and BSE ratio for each point in the CSV file format, while for X-ray
detector simulation results, you can export the X.-Y-Z coordinates, energy (keV),
Bremsstrahlung, and characteristic values for each point.

Specimen Generator

MC X-Ray’s Specimen generator now includes options to generate specimens within pre-
defined shapes, such as a cubes, cylinders within a cube, spherical inclusions, half and
half compositions, and spheres on platform. Click the Specimen tab to view the options
for generating specimens, as shown below.

Shape selections

- |Sphere on
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Non-Planar Views

As a new option for Dragonfly 2021.3, you can create projections based on a selected
sphere or cylinder as well as extract data from a curved plane. This means that 2D
views are no longer limited to simple slices through an object. With the Non-Planar View
mode, round or curved objects can now be unrolled or projected along their surface in a
“flat” 2D view. This provides a new option for the characterization of internal
geometries, for example in parts built by additive manufacturing (AM) or other
processes.

You should note that the Non-Planar View mode is a standard feature for all Dragonfly
licenses and that you can wrap all of the structured grids within a view — such as image
data, regions of interest, and multi-ROIs — inside a sphere or cylinder or that intersect
with a curved plane and then unwrap them in a non-planar 2D view.

Non-planar view (right) unwrapped from a cylindrical surface

Theta: 0.0 *

Radius: 142 4 cm

Extracting Non-Planar Views from Spheres or Cylinders

Two non-planar views — Sinusoidal and Equirectangular — are available for projecting
the surface of a sphere to a flat image (see Spherical Projections on page 46), while
cylindrical projections represent meridians as straight, evenly-spaced vertical lines and
circles of latitude (parallels) as straight horizontal lines (see Cylindrical Projections on
page 46).

Do the following to extract a non-planar 2D view from a sphere or cylinder:

1. Add a Sphere or Cylinder shape to the workspace.

NOTE In most cases, it is best to work in a workspace that includes both 2D
reformatted views and a 3D view.

2. Adjust the shape with the transform controls so that the shape follows the surface
that you want to inspect.

3. Select a view in the workspace.
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4. With the shape selected in Data Properties and Settings panel, choose Non-planar
2D view in the View mode drop-down menu in the Scene’s Views Properties panel,
as shown below.

‘roperties

annotations

The non-planar view extracted from the surface of the sphere or cylinder appears.

NoTE The following additional interactive text annotations are available for
manipulating non-planar views extracted from spheres and cylinders.

Annotation Description
Theta Lets you rotate the view around Theta (North Pole position).
Phi* Lets you rotate the view around Phi (Equator position).
Radius Lets you adjust the radius of the sphere or cylinder.
Projection* Lets you toggle the view from Equirectangular to Sinusoidal and vice-versa
(see Spherical Projections on page 46).

* For Spherical projections only.

Cylindrical Projections

Cylindrical projections, as shown below, represent meridians as straight, evenly-spaced
vertical lines and circles of latitude (parallels) as straight horizontal lines. In general,
this projection is best for objects which can be completely enclosed and visible within a
cylinder, without projecting or hollow parts.

Spherical Projections

Two non-planar views — Sinusoidal and Equirectangular — are available for projecting
the surface of a sphere to a flat image. You should note that spherical maps take into
account the sphere’s curvature, and each latitude line becomes evenly spaced. In
general, these projections are best for objects which can be completely enclosed and
visible within a sphere, without projecting or hollow parts.

Examples of the available spherical projections are shown in the following screen
captures.

Dragonfly Release Notes Version 2021.3

TMO021-A-10



TMO021-A-10

New Features and Product Enhancements
Non-Planar Views

Sinusoidal (top right) and Equirectangular (bottom right) non-planar views unwrapped from a spherical
surface

Theta 278.8
Phi: 297.7
Radius: 0.1 ¢

Theta: 228.8
Phi: 254.4

Radius: 0.1 em

Projection: Equirectangular

Sinusoidal... Is a pseudocylindrical, equal area projection in which equally spaced
parallels and a central meridian are straight lines and the other meridians are sinusoidal
curves, bulging away from the central meridian and equally spaced. Sinusoidal
projections present accurate area and distance at every parallel and at the central
meridian, while distortion increases at the outer meridians and at high latitudes. This is
illustrated in the following diagram:

Distortion at the outer meridians and at high latitudes

i
A//J A \

)
SN

As shown in the above diagram, the equator and the central meridian are the most
accurate parts of the projection, while distortion increases with distance from those
parts.

Equirectangular... Also called the equidistant cylindrical projection, an equirectangular
projection is a simple projection that maps meridians to vertical straight lines of
constant spacing (for meridional intervals of constant spacing), and circles of latitude to
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horizontal straight lines of constant spacing (for constant intervals of parallels). The
projection is neither equal area nor conformal because of the distortions introduced.

Extracting Non-Planar Views from Curved Planes

Dragonfly 2021.3 also includes the option to unroll tortuous planes using free form
surface inspection tools, such as Bezier patches (shown below) and Radial Basis
Function rectangles. With these tools, you can adjust the control points in 2D and 3D
view, add control points, and extract data as a one-slice image for inspection and
reporting.

Bezier patch

Do the following to extract a non-planar 2D view from a curved plane:

1. Draw a rectangle on the view that best corresponds to surface you want to inspect.

2. Right-click the annotation in the Data Properties and Settings panel and then choose
Create a Bezier Surface or Create a Radial Basis Function Surface in the pop-up
menu.

A Bezier patch or Visual RBF rectangle is added to the Data Properties and Settings
panel.

3. In the 2D or 3D view, adjust the patch or rectangle with the control points so that it
corresponds to the surface that you want to inspect.

NOTE You need to hold down LErT CTRL to move a control point. This is the default for
the configured action for ‘Move the surface control points’.
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NOTE You can redistribute and sample the control points while you work by right-
clicking the patch or rectangle in the Data Properties and Settings panel and then
choosing Redistribute Control Points in the pop-up menu.

NOTE You can also edit the shape properties — Density, which determines the
number of lines in the grid, and Thickness, which determines the weight on the
lines — in the Shape properties box, shown below.

¥ Shape properties

Density: :?:l

B8 e e, ————

4. Select the view in the workspace in which you want to unroll the tortuous plane.

5. With the patch or rectangle selected in Data Properties and Settings panel, choose
Non-planar 2D view in the View mode drop-down menu on the Scene’s Views
Properties panel, as shown below.

annotations

L~
b MIP {maximum}
mIP {minimum)
verage

The non-planar view extracted from the surface of the curved plane appears.

NoOTE If required, you can continue to modify the control points in the 2D or 3Dview.
The view of the curved plane will be updated in real time as you make your
adjustments.

Painting in Non-Planar Views

You can use the Brush and Point & Click ROI Painter tools in Multi-slice mode to label
pixels in non-planar views. You should note that in this case, the painting sphere or
cube will be aligned in world coordinates.

Extracting Non-Planar Projections

If required, you can extract a non-planar projection as a 2D image for archiving or for
further processing. This option is available in the Shape and Patch contextual menus.

Do the following to extract a projection as a 2D image:

1. Do one of the following:
e Right-click the sphere or cylinder from which the projection was unwrapped.

¢ Right-click the patch from the curved plane was extracted.

2. Choose Extract Projection of Structured Grid in the pop-up menu.
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3. Select the required structured grid in the Choose a Structured Grid to Extract

dialog, as shown below.

. Choose a Structured Grid to Project X

Object:

ng
jion of Interest

Leg
ulti-ROT

NOTE The structured grids you can extract data from include image data, regions of

interest, and multi-ROIs.

4. Click OK to extract the projection.

When extracted, the new object appears in the Data Properties and Settings panel.

Configured Actions for Non-Planar Views

The following actions can be configured for non-planar views in the Preferences dialog:

Configured actions for non-planar views

Action

Default key

Add or remove control points from Visual RBF rectangle

LEFT CTRL + Left mouse

Change projection mode Left mouse
Manipulate the cylinder Theta offset Left mouse
Manipulate the sphere north pole position Phi Left mouse
Manipulate the sphere north pole position Theta Left mouse
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3D Renderings and 3D Views

A number of enhancements for 3D renderings and 3D views, which include reflective
surfaces for virtual floors, optimizations for isosurfacing, improvements for applying
focus, and options to shown the 3D cursor and 2D view planes in 3D views, are
available in this software release.

NoTE This software release marks the deprecation of Dragonfly’s legacy rendering engine.

Virtual Floor

This software release includes the option to add reflective surfaces to ‘virtual floors’ in
3D views, as shown below.

Virtual floor with reflective surface

Check the Virtual floor option in the Scene’s Views Properties panel to add the floor to
the view and then check Reflective surface to add reflectivity. These options are circled
on the screen capture below.

Virtual floor settings
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Isosurface Renderings

This software release includes a number of optimizations for isosurfacing, which is a
highly efficient visualization technique for extracting a surface from 3D volumetric data.
By selecting an Isovalue, it is possible to visualize a surface corresponding to a
particular tissue type or material. Below is an example of an isosurface extracted from a
gothic prayer bead.

Isosurface rendering

Do the following to create an isosurface in a selected 3D view:

e Choose ISO as the Render mode in the Scene’s Views Properties panel, as shown
below.

Render mode:

Interacti

Background color:

e Select a value with the Isovalue slider, as shown below, or enter a value in the
Isovalue edit box. The Isovalue settings are available in the 3D settings box on the

|
[ High qui

[ Filtered gradient

Isovalue: —rk
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Using Focus

A number of improvements are included in this Dragonfly release for applying focus to
3D renderings. As shown in the example below, unwanted halo effects and artifacts
have been eliminated when blurring objects and features outside of focused region.

3D view with Focus enabled

You should note that the Focus settings, shown below, are available on Scene’s Views
Properties panel

Focus settings

¥ Focus
Enabl [ Auto focus [

Focal distance:

Depth of field

Show 3D Cursor

The 3D cursor can now be shown in 3D views. Right-click inside the 3D view and then
choose Show 3D Cursor in the pop-menu to enable the 3D cursor in the view, as shown
below.

3D cursor
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Render 2D View Planes

This software release also includes the option to show 2D view planes in the 3D view.
Right-click inside the 3D view and then choose Show 2D View Plane(s) in the pop-menu
to enable the 2D view planes in the view, as shown. The plane or planes will appear
when the 3D cursor is manipulated in any of the 2D views or if a 2D view is scrolled.

Rendered 2D view planes

Axis Indicator

A number of updates for the Axis Indicator, which indicates the orientation of 3D views,
are included in Dragonfly 2021.3.

Style... When displayed as arrows, the Axis Indicator now includes titles for the
orientation axes, as shown in the following screen capture.

Right-click a 3D view and then choose Axis Indicator > Arrows in the pop-up menu to
change the appearance of the Axis Indicator.

Position... You can now choose to position the Axis Indicator at the bottom right or
bottom left corner of the 3D view. The options, which are circled on the following screen
capture, are available in the Axis position box in the 3D Settings preferences.

Axis indicator preferences

Axis indicator

Default preset: Grayscale

Distributed Tasks
Deep Learning

Default W/L mode: Left-gated ramp
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Clipping

A number of new preferences and settings are available for clipping in this software
release.

Configurable axis lengths... A new 3D Settings preference for the clip box — Axis
length factor (% of box) — lets you choose an axis overshoot of the clip box, as shown
below.

Clip box visibility... A new setting on the Data Properties and Settings panel, circled
below, lets you choose to keep a clip box visible when the object to which it is
associated is hidden.

¥ Clip
Grid size: 0.50 cm

n object is hidden

Grid lines [v] Borders []
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Regions of Interest

The options to apply LUTs and smoothing to regions of interest, as well as
improvements for visualizations of ROIs without image data, are available for Dragonfly
2021.3. In addition, the option to create images from the scalar values computed for a
multi-ROI is also available in this software release.

Applying LUTs

An additional visualization option for regions of interest is available in this software
release. As shown in the following screen captures, you can apply a LUT to an ROI in 3D
and 2D views.

ROI with solid color highlight (left) and with LUT applied (right)

m

To apply a LUT to an ROI, select the option Use LUT in the Opacity and color box on the
Data Properties and Settings panel, as shown below. You can then select the required

LUT by clicking the corresponding color box in the Data Properties and Settings object
list. LUTs will be available in the LUT dialog.

Opacity and color box

Labeled data:

NoTE For both 2D and 3D views, colors of the applied LUT will be mapped to the underlying
dataset values.

Visualizations without Image Data

You should notice a marked improvement for visualizing regions of interest without a
dataset. Regions of interest should now appear less pixelated with improved shading, as
shown in the following screen capture.
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ROI without a dataset

Smoothing ROIs... You can further improve visualizations of regions of interest that are
shown without a dataset by smoothing. The option to apply smoothing is available in
the Opacity and color box on the Data Properties and Settings panel, as circled below.
Opacity and color box

¥ Opadty and color

Creating Images from Scalars

This software release includes the option to create images from the scalar values
computed for a multi-ROI. For example, in cases in which you have done a connected
components analysis. Right-click the required multi-ROI in the Data Properties and
Settings panel and then choose Create Images from Scalars in the pop-up menu. You
can then select the scalars from which you want to create your new images in the
Select Scalars dialog, shown below.

Select Scalars dialog

B select Scalars X

[ equivalent_diameter
[ extended_diameter
ibed_diameter

[ surface_area

L

NoOTE You can assign dimension units to images created from scalars (see Image Properties
(Dimension Units) on page 30). For example, meters to diameters, m? to areas, and m3
to volumes.
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ROI Painter

When using the ROI Painter tools, you can now view and edit the size of the brush on
the ROI Painter panel.

Brush size

¥ Brush size

mm

Diameter: 0.0735

NoTE As of Dragonfly 2021.3, the highlight will not be shown in 3D views when painting until the

mouse is released. In 2D views, the highlight will be updated continuously while painting.

Graphs and Vector Fields

A level-of-detail (LOD) mechanism was implemented in this software release to help
increase the speed of rendering for graphs and vector fields during manipulations. For
graphs, the rendering of vertices is removed during movement while edges are still
show. For vector fields, arrow heads are removed during movement.

To enable LOD for graphs, select the Enable level of detail option in the Graph settings
box, as shown below.

Graph settings

¥ Graph settings

‘ [#] Enable level of detail

Edge radius surement: Edge length
Edge rat —
[ Use scalar real scale as edge radius

Min: 13.29 pm B

Edge LUT measurement: Constant
Edges LUT: . EEE

Min: 1 Ma: 1

Vertex LUT measurement: Connectivity

e LUIT= . BL-GR-YL

Min: 0 Max: 15

il B

NoTE The level of detail mechanism is implemented at all times for vector fields.
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Meshes

A number of new options and updates for meshes, described below, are available in
Dragonfly 2021.3.

Thickness Analyses

An additional method is available in this software release for obtaining thickness values
from the mesh of a single, closed 3D shape. In this directional method, known as
normal ray tracing, a ray is passed normal to the mesh surface and its intersection with
the opposite surface is computed to obtain the thickness value. The Euclidean (straight
line) distance between the intersections is considered as the thickness at the given
point.

Right-click a mesh in the Data Properties and Settings panel and then choose Compute
Ray-Tracing Thickness to compute thickness with this method.

Thickness determination by normal ray-tracing

NoTE If the two surfaces containing the intersection points are not parallel, then the thickness
values computed at the two opposite points will be different depending on the ray
direction. This may lead to conflicting results for the pair of points.

NoTE Dragonfly also provides an alternate method for complex, organic geometries. This
option, in which regions of interest are exported as thickness meshes and thickness is
determined through inscribed spheres, is available on the ROI Tools panel.
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Mesh Capping

This software release also includes the option to cap meshes on the active clip box face.
Check the Cap mesh on active clipbox face option, circled below, in the 3D settings box
to cap a clipped mesh.

3D settings for meshes

An example of the original clipped mesh and the capped version is available in the
following screen captures.

Uncapped versus capped mesh

e

4L
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Shapes

This software release includes the options to fit a sphere or cylinder to a series of
points, as shown below.

Cylinder fit to points

Do the following to create a new cylinder or sphere fitted to a series of points:
e Create a points set that describes the surface you want to enclose within a sphere or
cylinder

¢ Right-click the points set and then choose Fit a Cylinder from the Point Annotation or
Fit a Sphere from the Point Annotation in the pop-up menu.

A new cylinder or sphere is added to the Data Properties and Settings panel.

NoTE You will need a minimum of three points to fit a sphere to a points set and a minimum of
six points to fit a cylinder to a points set.

NoTE Points can now be added and positioned in 3D views, in which they appear as spheres.
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Movie Maker

Updates for Dragonfly’s Movie Maker include additional bitrate options adapted for
different needs. Click the Export Animation button on the Movie Maker panel to open
the Export Animation dialog. The Bitrate options are shown in the screen capture below.

Export Animation dialog

. Export Animation X

Video dimensions:
Dimensions presets: 1280x720

End time:

tup

mpegdinavi * Bitrate: |

Bitrates, which determine the number of bits that are conveyed or processed per unit of
time, are computed in Dragonfly’s Movie Maker as:

bitrate = [(width * height * FPS) * motion factor * constant] / 1000,
in which the motion factor varies on the selected quality and the

constant is 0.15

Although higher bitrates generally result in better video quality, they will increase file
size dramatically. You should choose a bitrate that is suitable for the amount of motion
included within your animation.

Adaptive bitrate... The motion fador is set to 4 for this setting, which should be suitable
for most videos.

High bitrate... The motion factor is set to 6 for this setting, which should be suitable for
videos with high motion.

Medium bitrate... The motion factor is set to 2 for this setting.

Low bitrate... The motion factor is set to 1 for this setting.

Screen Recorder

Now includes options to record audio with your microphone, as well to save a lower
resolution file with the original recording.

Choose Utilities > Screen Recorder on the menu bar to open the Screen Recorder
dialog, shown below.

Screen Recorder dialog

B 5creen Recorder - X

Include audio

Als e lower resolution file
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Artificial Data Generator

The Artificial Data Generator lets you generate image data, regions of interest, and
multi-ROIs for analysis, testing, and other purposes.

Choose Utilities > Artificial Data Generator on the menu bar to open the Create an
Object dialog. You can choose to create an image, region of interest, or multi-ROI in the
Object type drop-down menu.

The options for creating artificial image data are shown in the following screen capture.

Create an Object dialog for images

. Create an Object = O X

type: Image
0.001

Mame: Created Object

0.001

0.001

Total size (]
Algorithms

Make a maze

Data type
dd noise
Number of thre;
Random seed:

Std:

NoTE The Create an Image item in the File menu was deprecated in this software release. All
of the options previously available in the Create an Image dialog are now available in the
Create an Object dialog.

The options for creating regions of interest and multi-ROIs are shown in the following
screen capture.
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Create an Object dialog for ROIs and multi-ROls

B Create an Object - O X

0.001

: Created Object

0.001

0.001

Total s

Algorithms

Padding

This new option for Dragonfly 2021.3 lets you add padding to volumetric image data,
regions of interest, and multi-ROIs. Right-click the required structured grid in the Data
Properties and Settings panel and then choose Modify and Transform > Padding in the
pop-up menu to open the Dataset Padding panel, shown below.

Dataset Padding panel

Minus
1000
1000

1000

Crea

You can choose a value for the padded area voxels, as well as set padding to the plus
and/or minus side of each axis.

NOTE You can also choose the pop-up menu item Make a Padded Copy. In this case, a series
of dialogs will then appear that let you choose the padding for the X, Y, and Z axes, as
well as a value for the added voxels.

M » Padding X
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New Features and Product Enhancements
CT Reconstruction

CT Reconstruction

A number of updates for the CT Reconstruction module, which provides for the
tomographic reconstruction of cone-beam and parallel-beam projections, are available
in this software release. These include:

o YXLON metadata parser now supports multiple versions of metadata files from
YXLON's FF 35 CT, MU2000-D, and Cheetah EVO X-ray and CT inspection systems.

¢ New metadata parser available for GE CT systems.

o New pre-processing phase retrieve filter for defective pixel correction.

e Support for parsing defective pixel maps from ROI files.

e Angular sampling for faster results when using ‘Image metric’ to find the center of
rotation.

Hyperspectral Imaging

This software release includes support for the LANL CXRF file format for Hyperspectral
Imaging. You should note that confocal X-ray fluorescence microscopy (CXRF) can be
used to acquire 3D depth profiling of the elemental composition of a sample.

Customizing Workspaces

You can now choose to close a number of the workspace panels to optimize the space
available on the left sidebar. Click the *X’ to close a workspace panel, as shown below.

Workspace panels

Layout

Views (in the selected scene)

TE¥a

Leveling

To reinstate a closed panel, choose Utilities > Open Plugins on the menu bar and then
select the plugin you need to open.

NoTE The Window Leveling panel needs at least one instance at all times and you cannot close
the last one.
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Menu Bar Changes
File Menu

Menu Bar Changes

The following new items are available on the menu bar in Dragonfly 2021.3. Other
changes are also listed here.

File Menu

A number of changes, listed below, were implemented in the File menu.

File menu changes

Description

Create an Image

This item was deprecated for Dragonfly 2021.3. The option to create an artificial image is now available in

the Utilities menu (see Atrtificial Data Generator on page 63).

Artificial Intelligence Menu

A number of new items, listed below, are available in the Artificial Intelligence menu.

Artificial Intelligence menu changes

Description

Filter with Al

Lets you apply deep learning regression models that you trained, imported, or downloaded for denoising

and super resolution tasks (see Filter with Al on page 25).

Utilities Menu

A number of new items, listed below, are available in the Utilities menu.

Utilities menu changes

Description

Dimension Unit Manager

Lets you create new units and calibration standards for intensity scale calibrations (see Dimension Unit
Manager on page 29).

Artificial Data Generator

Lets you generate image data, regions of interest, and multi-ROIs for analysis, testing, and other

purposes (see Artificial Data Generator on page 63).
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Changes to Contextual Menus

Dataset Pop-Up Menu

Changes to Contextual Menus

The following changes for the contextual menus available in the Data Properties and
Settings panel are implemented in Dragonfly 2021.3.

Dataset Pop-Up Menu

A number of new items, listed below, are available in the Dataset pop-up menu.

Dataset pop-up menu changes

Description

Modify and Transform

A new item available in the submenu, Padding, lets you add padding to a dataset (see Padding on
page 64).

Filter with Al

Lets you apply deep learning regression models that you trained, imported, or downloaded for denoising
and super resolution tasks (see Filter with Al on page 25).

Make a Padded Copy

Lets you make a copy of the selected image data with padding on the X, Y, and Z axes (see Padding on
page 64).

Calibrate Intensity Scale

Lets you calibrate an image to a set of calibration standards (see Intensity Scale Calibrations on page 28).

Calibrate Spatial Scale

Lets you define the spatial scale so that measurement results are presented with the correct values (see

Spatial Scale Calibrations on page 31).

ROI Pop-Up Menu

A number of new items, listed below, are available in the ROl pop-up menu.

ROI pop-up menu changes

Description

Modify and Transform

A new item available in the submenu, Padding, lets you add padding to a region of interest (see Padding
on page 64).

Make a Padded Copy

Lets you make a copy of the selected region of interest with padding on the X, Y, and Z axes (see Padding
on page 64).

Calibrate Spatial Scale

Lets you define the spatial scale so that measurement results are presented with the correct values (see
Spatial Scale Calibrations on page 31).

Multi-ROI Pop-Up Menu

A number of new items, listed below, are available in the Multi-ROI pop-up menu.

Multi-ROI pop-up menu changes

Description

Modify and Transform

A new item available in the submenu, Padding, lets you add padding to a multi-ROI (see Padding on
page 64).

Create Images from Scalars

Lets you create images from the scalar values computed for a multi-ROI (see Creating Images from
Scalars on page 57).

Make a Padded Copy

Lets you make a copy of the selected multi-ROI with padding on the X, Y, and Z axes (see Padding on
page 64).

Scalar Generator

Lets you compute basic measurements, measurements extracted from a dataset, as well as add other
values, such as the number of voxels intersecting with another object (see Scalar Generator on page 32).
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Mesh Pop-Up Menu

Description

Calibrate Spatial Scale

Lets you define the spatial scale so that measurement results are presented with the correct values (see

Spatial Scale Calibrations on page 31).

Mesh Pop-Up Menu

A number of new items, listed below, are available in the Mesh pop-up menu.

Mesh pop-up menu changes

Description

Compute Ray-Tracing
Thickness

Lets you obtain thickness values using the normal ray tracing method (see Thickness Analyses on
page 59).

Scalar Generator

Lets you add measurements, scalar values, and constants (see Scalar Generator on page 32).

Graph Pop-Up Menu

A number of new items, listed below, are available in the Graph pop-up menu.

Graph pop-up menu changes

Description

Scalar Generator

Lets you add measurements, scalar values, and constants (see Scalar Generator on page 32).

Vector Field Pop-Up Menu

A number of new items, listed below, are available in the Vector Field pop-up menu.

Vector Field pop-up menu changes

Description

Scalar Generator

Lets you add measurements, scalar values, and constants (see Scalar Generator on page 32).

Annotations Pop-Up Menu

A number of new items, listed below, are available in the Annotations pop-up menu.

Annotations pop-up menu changes

Description

Create a Bezier Surface*

Creates a Bezier patch, which can be adjusted and then unrolled in a non-planar view (see Extracting
Non-Planar Views from Curved Planes on page 48).

Create a Radial Basis
Function Surface*

Creates a Visual RBF rectangle, which can be adjusted and then unrolled in a non-planar view (see
Extracting Non-Planar Views from Curved Planes on page 48).

* For rectangular regions only.
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Preferences Changes
Shapes Pop-Up Menu

Shapes Pop-Up Menu

A number of new items, listed below, are available in the Shapes pop-up menu.

Shapes pop-up menu changes

Description

Extract Projection of
Structured Grid*

Lets you extract a non-planar projection from a dataset as a 2D image for archiving or for further
processing (see Extracting Non-Planar Projections on page 49).

Redistribute Control Points**

Lets you resample and/or redistribute the control points for Bezier patches and Visual RBF rectangles.

* For cylinders, spheres, Bezier patches, and Visual RBF rectangles.
** For Bezier patches and Visual RBF rectangles only.

Preferences Changes

A number of new items, listed below, and other changes have been implemented for
setting the application preferences.

Click Preferences on the Status bar or choose File > Preferences on the Menu bar to
open the Preferences dialog.

Views Preferences

Changes for the Views preferences are indicated in the following table.

Views preferences changes

Description

3D Settings

Axis indicator

Includes a new option for setting the position of the Axis indicator — ‘Right corner’ or ‘Left corner’.

Clip box

Includes the new setting Axis length factor (% of box) for setting an axis overshoot of the clip box (see
Clipping on page 55).

Depth sorting when using
shapes

Item deprecated. A new option, ‘Accurate depth sorting’, in the 3D settings panel replaces this preference.

Annotations

Scale bar Includes the new scale bar properties that can be set as preferences (see Scale Bar Properties on
page 41).

Rulers Includes the new ruler properties that can be set as preferences (see Ruler Properties on page 37).

Arrows Includes the new arrow properties that can be set as preferences (see Arrow Properties on page 40).

Organizer Preferences

Changes for the Organizer preferences are indicated in the following table.

Organizer preferences changes

Description

Items shown in recent
projects list

Lets you set the maximum number of items that will be shown in the Recent list (see Organizer on
page 6).

Object Research Systems (ORS) Inc.

69



70 | Preferences Changes
Configurable Actions

Configurable Actions

New configurable actions are available for working with the surface inspection tools and
opening plugins. Chose File > Preferences > Configurable Actions to access the
configurable actions for Dragonfly.

New configurable actions

Action Default Configuration

For non-planar views

Add a control point to Visual RBF rectangle Not defined
Change projection mode Left mouse
Manipulate the cylinder Theta offset Left mouse
Manipulate the sphere north pole position Phi Left mouse
Manipulate the sphere north pole position Theta Left mouse
Move the surface control points LEFT CTRL + Left mouse
Remove a control point fro Visual RBF rectangle Not defined
Miscellaneous

Go to Previous Non-Empty Slice of ROI, Multi-ROI or Image Right
(Image Plane Only)

Open Macro Player Not defined

Deep Learning Preferences

A new set of Deep Learning preferences are available in Dragonfly 2021.3 to enable the
checkpoint cache option and to set the size limits for the cache.

Deep Learning preferences

Description

GPU card for Deep Learning | Lets you choose a specific GPU card for Deep Learning.

Enable checkpoint cache Check this item to enable the checkpoint cache, which lets you load and then save a model at a selected
checkpoint (see Loading and Saving Model Checkpoints on page 23).

Maximum cache disk space per model... Lets you set the per model limit for the cache disk space.

Total cache disk space usage... Indicates the total size of the checkpoint cache. If required, you can
clear the checkpoint cache by clicking Clear cache.
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Resolved Issues

Resolved Issues
Third-Party Packages

A number of issues reported by users have been resolved in this software release.

These include the following:

e Issues with Brush cursor for painting when working remotely or on Linux have been

resolved.

e Issues with the Screen Recorder have been resolved. Originally reported for the Beta
version of Dragonfly 2021.3.

e The scale bar is now shown in the correct size in screenshots that are exported at

higher resolutions than the screen.

e Dragonfly 2021.3 includes support for RTX3000 cards for Deep Learning.

System Requirements

This release supports the base system requirements for Windows.

For the Linux version, supported operating systems now start from Ubuntu 18.04 (see
http://www.theobjects.com/dragonfly/system-requirements.html).

Third-Party Packages

You should note that the third-party packages listed below were updated for this

release:

Updated third-party packages

Item 2021.3 Previous release
TensorFlow 241 1.14.0

Qt 5.12.9 5.9

Python 3.8.6 3.7.3
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Publicly Available Source Code

TensorFlow

Publicly Available Source Code

Users can freely download and examine the source code of the following.

TensorFlow

A number of Dragonfly’s artificial intelligence applications, such as the Deep Learning
Tool, the Segmentation Wizard, and Segment with AI, use TensorFlow APIs to facilitate
training and inference of deep neural networks. Created by the Google Brain team,
TensorFlow is a free and open-source library widely used for deep learning applications
and traditional machine learning.

Users can freely download and examine the TensorFlow source code from:

https://github.com/tensorflow/tensorflow/releases/tag/v2.4.1.

Qt

Dragonfly is designed and developed with Qt, which is a free and open-source toolkit for
creating graphical user interfaces and cross-platform applications. Qt is developed by
The Qt Company, a publicly listed company, and is available under both commercial
licenses and open-source GPL 2.0, GPL 3.0, and LGPL 3.0 licenses.

Users can freely download and examine the Qt source code from:

https://download.qt.io/official_releases/qt/5.12/5.12.9/.
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Dragonfly Workshops

Extending Dragonfly

Dragonfly’s Infinite Toolbox, an open exchange platform for the Dragonfly user
community, lets you submit, browse, and download extensions that implement new
features and workflows for all of your image processing or analysis needs.

Choose Utilities > Infinite Toolbox on the menu bar to open Dragonfly’s Infinite Toolbox.

Requesting New Features

Let us know if you have a suggestion for a new feature, or an idea for an improvement
to an existing workflow.

Learning Dragonfly

You'll find some great free resources, such as our latest instructional videos, recorded
webinars, and user forums just by taking a quick look around www.theobjects.com/
dragonfly/. You can also take advantage of the course offerings listed below to further
benefit from our training team's in-depth product knowledge.

Dragonfly Workshops

Our hands-on training workshops are a great way to get up and running quickly.
Combining in-depth instruction with class exercises, our product specialists will quickly
teach you how to use key Dragonfly features and functions to optimize your image
visualization and analysis tasks.

NoTe All scheduled Dragonfly workshops have been postponed or cancelled due to worries
about the coronavirus pandemic. We will resume our workshop schedule as soon as
possible. You can check for updates at http://www.theobjects.com/dragonfly/
workshops.html.

Online Training

Get connected with an online training session and follow along with a Dragonfly product
specialist as they demonstrate the features and benefits of Dragonfly and walk you
through specialized modules. Web-based training, which can be adapted to individual
needs and interests, offers an interactive approach that lets you practice new
techniques on numerous case studies.

NoTE Online training is available upon request. Contact support@theobjects.com for
information about availability.
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Reporting Issues
Online Training

Reporting Issues

Dragonfly includes an integrated reporting module that lets you include comments and
other information along with generated DMP and log files whenever you encounter an
issue that results in a crash or application freeze.

Send Report to ORS dialog

85 Send Reportto ORS = O X

Please provide as much infermation as pessible to help ORS understand the
circumstances under which the problem eccurred.

Name: |J0hn Doe |

Email: |i0hn.doe @mycompany.com |

Reference (optional): |Image processing |

Details: An issue occumed when nomalizing data after applying the polynominal
fiter to comect uneven shading.

The original dataset is available for investigating the issue.
Sincerely,

Jo|

0K Cancel

You should note that you can also report an issue at any time by choosing Help >
Report an Issue on the menu bar.
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